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SPECIFICATIONS ARE SUBJECT TO CHANGE WITHOUT NOTICE 

NOTICES LIST 

While reasonable efforts have been made to assure the accuracy of this document, Telit assumes 
no liability resulting from any inaccuracies or omissions in this document, or from use of the 
information obtained herein. The information in this document has been carefully checked and is 
believed to be reliable. However, no responsibility is assumed for inaccuracies or omissions. Telit 
reserves the right to make changes to any products described herein and reserves the right to 
revise this document and to make changes from time to time in content hereof with no obligation 
to notify any person of revisions or changes. Telit does not assume any liability arising out of the 
application or use of any product, software, or circuit described herein; neither does it convey 
license under its patent rights or the rights of others. 

It is possible that this publication may contain references to, or information about Telit products 
(machines and programs), programming, or services that are not announced in your country. Such 
references or information must not be construed to mean that Telit intends to announce such Telit 
products, programming, or services in your country. 

COPYRIGHTS 

This instruction manual and the Telit products described in this instruction manual may be, include 
or describe copyrighted Telit material, such as computer programs stored in semiconductor 
memories or other media. Laws in the Italy and other countries preserve for Telit and its licensors 
certain exclusive rights for copyrighted material, including the exclusive right to copy, reproduce 
in any form, distribute and make derivative works of the copyrighted material. Accordingly, any 
copyrighted material of Telit and its licensors contained herein or in the Telit products described 
in this instruction manual may not be copied, reproduced, distributed, merged or modified in any 
manner without the express written permission of Telit. Furthermore, the purchase of Telit 
products shall not be deemed to grant either directly or by implication, estoppel, or otherwise, any 
license under the copyrights, patents or patent applications of Telit, as arises by operation of law 
in the sale of a product. 

COMPUTER SOFTWARE COPYRIGHTS 

The Telit and third Party supplied Software (SW) products described in this instruction manual 
may include copyrighted Telit and other third Party supplied computer programs stored in 
semiconductor memories or other media. Laws in the Italy and other countries preserve for Telit 
and other third Party supplied SW certain exclusive rights for copyrighted computer programs, 
including the exclusive right to copy or reproduce in any form the copyrighted computer program. 
Accordingly, any copyrighted Telit or other 3rd Party supplied SW computer programs contained 
in the Telit products described in this instruction manual may not be copied (reverse engineered) 
or reproduced in any manner without the express written permission of Telit or the 3rd Party SW 
supplier. Furthermore, the purchase of Telit products shall not be deemed to grant either directly 
or by implication, estoppel, or otherwise, any license under the copyrights, patents or patent 
applications of Telit or other 3rd Party supplied SW, except for the normal non-exclusive, royalty 
free license to use that arises by operation of law in the sale of a product.  
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USAGE AND DISCLOSURE RESTRICTIONS 

I. License Agreements 

The software described in this document is the property of Telit and its licensors. It is furnished by 
express license agreement only and may be used only in accordance with the terms of such an 
agreement. 

II. Copyrighted Materials 

Software and documentation are copyrighted materials. Making unauthorized copies is prohibited 
by law. No part of the software or documentation may be reproduced, transmitted, transcribed, 
stored in a retrieval system, or translated into any language or computer language, in any form or 
by any means, without prior written permission of Telit 

III. High Risk Materials 

Components, units, or third-party products used in the product described herein are NOT fault-
tolerant and are NOT designed, manufactured, or intended for use as on-line control equipment 
in the following hazardous environments requiring fail-safe controls: the operation of Nuclear 
Facilities, Aircraft Navigation or Aircraft Communication Systems, Air Traffic Control, Life Support, 
or Weapons Systems (High Risk Activities"). Telit and its supplier(s) specifically disclaim any 
expressed or implied warranty of fitness for such High-Risk Activities. 

IV. Trademarks 

TELIT and the Stylized T Logo are registered in Trademark Office. All other product or service 
names are the property of their respective owners.  

V. Third Party Rights 

The software may include Third Party Right software. In this case, you agree to comply with all 
terms and conditions imposed on you in respect of such separate software. In addition to Third 
Party Terms, the disclaimer of warranty and limitation of liability provisions in this License shall 
apply to the Third-Party Right software. 

TELIT HEREBY DISCLAIMS ANY AND ALL WARRANTIES EXPRESS OR IMPLIED FROM ANY 
THIRD PARTIES REGARDING ANY SEPARATE FILES, ANY THIRD-PARTY MATERIALS 
INCLUDED IN THE SOFTWARE, ANY THIRD-PARTY MATERIALS FROM WHICH THE 
SOFTWARE IS DERIVED (COLLECTIVELY “OTHER CODE”), AND THE USE OF ANY OR ALL 
THE OTHER CODE IN CONNECTION WITH THE SOFTWARE, INCLUDING (WITHOUT 
LIMITATION) ANY WARRANTIES OF SATISFACTORY QUALITY OR FITNESS FOR A 
PARTICULAR PURPOSE. 

NO THIRD PARTY LICENSORS OF OTHER CODE SHALL HAVE ANY LIABILITY FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING WITHOUT LIMITATION LOST PROFITS), HOWEVER CAUSED AND WHETHER 
MADE UNDER CONTRACT, TORT OR OTHER LEGAL THEORY, ARISING IN ANY WAY OUT 
OF THE USE OR DISTRIBUTION OF THE OTHER CODE OR THE EXERCISE OF ANY RIGHTS 
GRANTED UNDER EITHER OR BOTH THIS LICENSE AND THE LEGAL TERMS APPLICABLE 
TO ANY SEPARATE FILES, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 
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APPLICABILITY TABLE 

 

PRODUCT 

  SL871 SC872-A 

SL869-V2 SE868-A 

SL871-S SL869-V2S 

SE868-AS  

 
SL869 SL869-DR 

SL869-T SL869-V3 

SL869-3DR SL869-V3T 

SL869-ADR  

 
JF2 SE880 

JN3 SE868-V2 

SE873 SE868-V3 

SL876-A  

 

 SW Version 

TelitView 2.1.7 
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 INTRODUCTION 

 Scope 

The scope of this document is to provide information on how to use the TelitView 
tool. 

More specifically, this document introduces the features contained in TelitView 
and how to use them to evaluate and be familiarized with the features and 
performances of Telit’s GNSS modules. 

This User Guide is intended for users interested in understanding Telit’s GNSS 
receiver modules, and who want to manage and control the device through 
messaging, and conduct tests on the Telit’s GNSS module.  

 Contact Information, Support 

For general contact, technical support services, technical questions and report 
documentation errors contact Telit Technical Support at: 

 

 TS-EMEA@telit.com 

 TS-AMERICAS@telit.com 

 TS-APAC@telit.com  

 TS-SRD@telit.com (for Short Range Devices) 

 

Alternatively, use: 

http://www.telit.com/support 

 

For detailed information about where you can buy the Telit modules or for 
recommendations on accessories and components visit: 

http://www.telit.com  

 

Our aim is to make this guide as helpful as possible. Keep us informed of your 
comments and suggestions for improvements. 

Telit appreciates feedback from the users of our information. 

 

 

  

mailto:TS-EMEA@telit.com
mailto:TS-AMERICAS@telit.com
mailto:TS-APAC@telit.com
mailto:TS-SRD@telit.com
http://www.telit.com/support
http://www.telit.com/
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 Text Conventions 

 

  

Danger – This information MUST be followed or 
catastrophic equipment failure or bodily injury may 
occur. 

 

 

  

Caution or Warning – Alerts the user to important 
points about integrating the module, if these points 
are not followed, the module and end user 
equipment may fail or malfunction. 

 

 

  

Tip or Information – Provides advice and 
suggestions that may be useful when integrating 
the module. 

 

 

All dates are in ISO 8601 format, i.e. YYYY-MM-DD. 

 

 

 Related Documents 

Please refer to the Applicability Table for the supported Telit GNSS modules. 
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 INSTALLATION OF TELITVIEW 

For each type of receiver, please refer to the Applicability Table for the supported 
Telit GNSS modules to install the applicable USB drivers and connect the 
receiver to the PC. 

 Downloading 

Go to the Telit Download Zone http://www.telit.com/download-zone/ . 

After Log In: Click on Software > GNSS > Software tools 

Download the latest Windows Installer Package file: TelitViewInstall_x_x_x.msi  

 System Requirements 

Microsoft .NET Framework 4.0 or later. 

If a user wants to determine which version of .NET Framework is installed in his 
computer, he can follow these procedures: 

 On the Start menu, in the search box, type: regedit 

 You must have administrative credentials to run regedit.exe. 

 In the Registry Editor, open the following sub key: 

 HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\NET 
Framework Setup\NDP 

 The installed versions are listed under the NDP sub key. The 
version number is stored in the Version entry. For the .NET 
Framework 4, the Version entry is under the Client or Full sub key 
(under NDP), or under both sub keys. 

 

 

Figure 2-1 Registry Editor 

  

http://www.telit.com/download-zone/
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 Installation 

TelitView is a Windows application. 

To install TelitView on your computer: 

Run the Windows Installer Package file: TelitViewInstall_x_x_x.msi (x_x_x is the 
version id), and follow the TelitView Setup Wizard: 

 

 

Figure 2-2 TelitView Setup Wizard 

 

 Next 

 

Figure 2-3 Select Installation Folder 

 Next 
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Figure 2-4 Confirm Installation 

 Next 

 

Figure 2-5 Installation Complete 

 Close. 

Like a typical Windows desktop application, the installer has just installed the 
TelitView application into the computer and it can be launched from the “Start” 
menu. 

Typically, the program is installed under 

“C:\Program Files (x86)\TELIT\TelitView x.x.x” folder (x.x.x is the version id). 

The executable file name is “TelitView_x_x_x.exe”. 

Find the application and double click on it to launch the program in the default 
placement. 
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 SETUP OF TELITVIEW 

 Program Start and the Main Interface 

After TelitView has been installed, launch the program by double-clicking the 
desktop icon (if there is one added during the installation process or by the user), 
or from the PC’s “Start” menu, clicking the shortcut name under: 

All Programs -> TelitView x.x.x -> TelitView x.x.x (x.x.x is the version id). 

Once the user launches the program for the first time after the installation, it 
appears on the screen like this: 

 

Figure 3-1 The Main user interface at the default layout of the windows 

 

Figure 3-2 Menu bar and the Tool bar 
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 Connecting TelitView with a GPS Receiver through a COM 
port 

To connect TelitView with a GPS receiver through an available COM port on PC, 
follow these steps: 

From the main menu, click Setup > Comm Port 

Or from the tool bar: Click the Comm Port icon   

 

The “Connect to Receiver” dialog box will pop up. 

 

Figure 3-3 Connect to Receiver dialog box 

If TelitView runs for the first time on a PC machine and it has not communicated 
with a Telit GNSS module, “Telit Module” field will display “NON-SPECIFIC”; 
otherwise, a module type from the last time TelitView run will be displayed. 

 

 Make Connection 

From the dropdown list: 

 Select the correct COM port connected to a GPS receiver. 

 Select the correct baud rate. 

 Select the type of Telit module connected (optional, see below). 

 Click “OK”. 

If the port is selected and the baud rate is set correctly, TelitView program will 
show the serial data activities on the screen, as well as the data plots in its open 
windows. 

The status bar will show the current communication state: “Connected [COMxx, 
Baud xxxx], as indicated by the following figure. 



 

01VV0301168 Rev. 8 Page 22 of 123 2017-09-15  

 

 

Figure 3-4 COM port communication state (with the current Session ID) 

 About Telit Module Type 

This selection is optional if the user is connecting the COM port to a receiver 
and only wants to see receiver’s data output activities as they are displayed on 
the view windows. A module type of any selection is not a requisite on the 
purpose of monitoring the data on views. 

The default type of “NON-SPECIFIC” indicates that no particular module type 
has been selected. 

 When must a module type be selected? 

TelitView can send any text string that a user creates as a command; the user 
has the responsibility to know the correct command – its syntax and the 
arguments – that is supported by the module with that TelitView is currently 
communicating. 

If a command is not supported by the module (an unrecognizable command), 
the command will be ignored.  In this case, some modules will echo the 
command string, other modules may simply ignore the command and provide 
nothing in response. 

In any situation, that user would like to use a built-in command; TelitView must 
know the type of the module with that it is currently communicating. 

The examples of this type of situations include the following 

- the restart command (the Hot, Warm, and Cold restart that is 
found on the tool bar of the TelitView),  

- the LoopIt test suits (refer to the section 7.6 Error! Reference 
source not found.) 

- the Basic Commands (refer to the section Error! Reference 
source not found. Error! Reference source not found.). 

Therefore, if the user plans to send commands to the module, he must have the 
Telit module type specified correctly, because those built-in commands are 
module specific. In those cases, the module must be a specific type that 
corresponds to the module connected, other than “NON-SPECIFIC” type.  User 
can make the selection either from this dialog box or from the menu selection 
for the product type, as described in the section 4.1 Setup Menu. 
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Other situations when a module type needs to be selected include when the user 
wants to view data associated with the type of satellite constellations.  For 
example, if the user wants to see TelitView display GLONASS, or BeiDou 
information in the signal view windows, a correct type of module needs to be 
specified for the target, as the output for those data is generated differently by 
different chipsets. 

 Status Bar 

Located at the bottom left corner is the status bar.  The status bar shows the 
current connection status of the COM port, such as the 

 Connection state: connected, disconnected, or no connection 

 COM port parameter: port name and baud rate (when the port is 
connected 

The status also shows additional information as related to the connection, such 
as a Session ID.  Please refer to the section Error! Reference source not 
found. Error! Reference source not found. for more details about the Session. 
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 INTRODUCTION TO MENUS AND TOOLBAR 

 Setup Menu 

 

 

Figure 4-1 Setup Menu 

The Setup Menu includes the following entries and their functions accordingly: 

 Comm Port 

Launches the “Connect to Receiver” dialog box to configure the COM 
port parameters and to the receiver connected to the COM port as 
the data source. 

 Replay 

Launches a File-open dialog box and allows the user to select and 
replay a pre-recorded data file (in a standard NMEA data format) as 
the data source. 

 Disconnect 

Disconnects the data source which is either the serial port or the 
replay of the log file. 

 Start Log 

Launches a File-open dialog box and allows the user to specify a file 
name to save the data. Then opens the file and starts to log the data. 

 Stop Log 

Closes the log file if one is open. 

 Products 

Selects the particular product type for the receiver module connected 
to the COM port. 

 Sessions 

Creates, runs, and manages sessions. 
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 Convert 

Conducts data conversion from a source file to various format in a 
destination file that can be used as input file for different kinds of post-
processing tools. 

 Exit 

Exits the program. 

 

 Views Menu 

 

Figure 4-2 Views Menu 

The Views Menu entries are the launching commands for the following windows: 

 Navigation States 

The display of the navigation data in a form of list on the second-
epoch update basis. 

 NMEA Monitor 

The primary “Console” to control (sending command messages) and 
monitor the messages constantly received by TelitView. 

 Signal Quality 

The display of the signal strength of satellites (GPS / GNSS) as they 
are received by the receiver, in dbHz. 

 Azimuth Elevation 

The display of the satellite in view in terms of their azimuth and 
elevation, and their usage status at the epoch. 

 Scatter Plot 

The display of the position / navigation tracks in the 2D adjacent plot, 
as well as the navigation status updates on the error estimate.  

 Data Overview 
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The display of navigation data in a tabular form with rows and 
columns, providing extended overview of the status and calculations 
on the second-epoch basis. 

 Data Charts 

The display of time-sequence of navigation data, in the parameters 
such as SVs in use, HDOP, Latitude, Longitude, Altitude (HAE), etc. 

 Custom Messages 

Custom configurable message window that allows user to adjust 
settings to display the received messages to be monitored. 

 

 Tools Menu 

 

Figure 4-3 Tools menu 

The Tools menu entries are the built-in tools in TelitView. 

The current implemented features include controls that are used when TelitView 
is being used like a data player, or “replay” mode. 

The features also contain entries that link to various tools that allow users to run 
different kinds of specific control and monitor tasks, as well as user specific 
command management provision. 

 Replay Data 

This is a set of control commands that enables the replaying of a log 
file at different speeds. 

While the speed control on replay is implemented under this Tools 
menu, opening a log file and closing it are implemented under Setup 
menu. 

 Pause 

This control has dual operations – to “pause” or to “resume”.  It is 
enabled during both types of data source – COM port serial data or 
the replay of a log file. 

  



 

01VV0301168 Rev. 8 Page 27 of 123 2017-09-15  

 

 Stop 

This control stops a Replay. 

 User Commands Manager 

The provision allows the user to load a User Commands File that is 
product specific XML file, and manage the User Commands 
contained in the file. 

User may access this menu for the following operations: 

 Add new user command, using the “New/Modify” submenu 

 Load the user commands, using the “Load User Commands to Menu” 
submenu 

Please refer to the section Error! Reference source not found. 
Error! Reference source not found. for more detailed information. 

 DR Control Panel 

This menu brings up the Dead Reckoning (DR) control panel used 
as DR control and display console.  It is used for DR specific testing 
and monitoring. 

 MO-DR Control Panel 

This menu brings up the MEMS only DR control panel used as DR 
control and display console.  It is used for MEMS specific testing and 
monitoring. 

 EPO Host Manager 

This menu brings up the EPO Host Manager.  This is a product 
specific tool used to manage the EPO feature provided in SL869-V2 
(or other Telit GNSS modules that use devices from Mediatek Inc®). 

 Auto-baud to NMEA Protocol 

This menu launches TelitView’s auto-baud rate detection feature to 
detect the baud rate that the GNSS module currently runs to the PC 
COM port.  
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 Commands Menu 

 

Figure 4-4 “Commands” menu 

The Commands menu entries contain two types of the command sets: 

 Basic Commands 

These commands are provided as the built-in commands by 
TelitView, from the relevant XML file installed during the installation 
process. 

 User Commands 

These commands are created and maintained by the user, and by 
nature are custom created and customer specific to meet testing and 
control purposes for the customer. 

Please refer to the section Error! Reference source not found. 
Error! Reference source not found. for more details. 

 Test Menu 

 

Figure 4-5 "Test" menu 

The Test menu entries contain the following commands specific to functions of 
running tests. 

 Set Reference Position 

Launches a dialog box that allows the user to configure TelitView to 
use a position as a reference. The position is specified in the form of 
Latitude, Longitude, and Altitude values. 

Please refer to the section Error! Reference source not found. 
Error! Reference source not found. for more details. 

 LoopIt! Test 

TelitView provides this utility for users who wish to run a repeated 
TTFF test, with a test suite with configurable parameters to meet 
different testing needs. 
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 Special Settings 

This menu leads to a dialog box that allows user to set up various 
testing flags or TelitView system special conditions or changes the 
default behavior of TelitView. 

 Windows Menu 

 

Figure 4-6 "Windows" menu 

This Windows menu contains the commands for TelitView’s windows placement 
management. 

 Cascade 

 Tile Horizontal 

 Tile Vertical 

 Restore Default Placement of Windows 

These commands and their actions are self-explanatory. 

After installing the program and running it for the first time, placement of the 
windows in TelitView is persistent – TelitView will start with the placement from 
the last time the user exits the program. 

The last command in this menu, “Restore Default Placement of Windows”, is 
provided for the user to restore the default placement of selected view windows 
when the TelitView is installed for the first time. 
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 Help Menu 

 

Figure 4-7 "Help" menu 

The Help menu includes the following: 

 About TelitView 

 User’s Manual 

These commands and their actions are self-explanatory. 

 Toolbar/Icons and Their Functionalities 

Like a typical Windows application, TelitView provides the user a toolbar for 
quick access to features that are correspond to the menu entries listed. 

 

Figure 4-8 Toolbar on TelitView 
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Icon Name Functionality 

 

Comm Port Launches a dialog box to 
configure a COM port, and open 
it (to connect it to the receiver). 

 

Replay Launches an Open File dialog 
box and opens a log file, and 
replays it.  

 

Disconnect Disconnects the current open 
data source, either the open 
COM port or open replay file. 

 

Rewind Rewinds the replay file (to the 
beginning). 

This feature is enabled only in 
the data replay mode. 

 

Pause/Resume Pauses / Resumes the display. 

This feature is enabled in either 
COM port or data replay mode. 

      

 

Replay stop  
and Play 

Both icons share the same 
toolbar button. 

Replay stop is enabled when the 
program is in the data replay 
mode. When pressed, it is to 
stop the replay. 

Play is enabled when user 
pressed “Rewind” to direct the 
replay back to the beginning of 
the replay file, he may press this 
Play button to start to replay. 

 

Start log Launches an Open File dialog 
box, and starts to log the data 
into a disk file. 

 
Stop log Stops (closes) the log file that is 

open to save the data.  

 

Navigation 
status 

Launches the “Navigation 
Status” window. 

 

NMEA Monitor Launches the “MNEA Monitor” 
window. 

 

Signal Quality Launches the “Signal Quality” 
window. 
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Azimuth 
Elevation 

Launches the “Azimuth 
Elevation” window. 

 

Scatter Plot Launches the “Scatter Plot” 
window. 

 

Data Overview Launches the “Data Overview” 
window. 

 

Data Chart 

 

Launches the “Data Chart” 
window. 

 

Hot Reset Command to send a “Hot Reset” 
message to receiver through the 
COM port. 

The actual message content is 
product-specific. 

 

Warm Reset Command to send a “Warm 
Reset” message to receiver 
through the COM port. 

The actual message content is 
product-specific. 

 

Cold Reset Command to send a “Cold 
Reset” message to receiver 
through the COM port. 

The actual message content is 
product-specific. 

Figure 4-9 Toolbar icons and their functions 

 

  



 

01VV0301168 Rev. 8 Page 33 of 123 2017-09-15  

 INTRODUCTION TO VIEWS WINDOWS 

This section introduces each window of TelitView under the “Views” menu, 
descriptions on the operations / utilities available to users, as well as how to use 
them. 

 Context Menus 

As a common control feature, many windows have the context menu available 
to users. Typically, the context menus contain the combination of the following 
commands or features: 

 “Clear”: 

Clears the data or plot that pertains to the data in the view. Where it 
is applicable, variables such as the data count will be reset. 

 “Copy”: 

Copies the content selected by the user to the clipboard. 

In some situations, the user needs to use the Windows-style copy-
paste technique for the extended selection. 

For instance, while on one of the plots, right-clicking on the mouse 
key will bring out a “Clear” command. User can elect to clear the plot 
and restart plot over again. 

 Navigation States Window 

This is the navigation data display in a list with useful information pertaining to 
the current epoch. 

The displayed satellite measurement information includes the position 
information, DOPs, GNSS satellites (GPS, GLONASS, Galileo, BeiDou, etc.) 
that are in-view and are used for the fix, course information, etc. 

It also contains test stats such as the fix status and TTFF information, if 
applicable. 

 

Figure 5-1 Navigation States view 

 



 

01VV0301168 Rev. 8 Page 34 of 123 2017-09-15  

Position related status and their setting source: 

(1) “Mode”: the GSA message is the source for the data - Mode 
field (no fix; 2D fix; 3D fix) 

(2) “Status”: the RMC message is the source for the data – 
Status field (Invalid; Valid; Differential) 

(3) “Position Type”: the GGA message is the source for the data 
– GPS Quality (Invalid: SPS; DGPS; etc.) 

 Time-To-First-Fix on GNSS 

The following figure illustrates the navigation states values, along with a TTFF = 
2.2 second.  The Time to First Fix (TTFF) is on GNSS (vs Dead Reckoning, for 
instance).  

 

 

 

Figure 5-2 Navigation States window and TTFF display 
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 Time-To-First-Fix on Dead Reckoning (DR) 

The following figure illustrates the navigation states values, along with a TTFF = 
4.9 second.  The Time to First Fix is on Dead Reckoning (vs GNSS broadcasting 
signals, for instance). 

 

 

Figure 5-3 Navigation States window and TTFF with DR 
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 NMEA Monitor 

 Menu: Views > NMEA Monitor 

 

 

Figure 5-4 NMEA monitor view 

 

 

Figure 5-5 NMEA monitor controls and fields 
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 Controls on the Window 

The NMEA Monitor contains a collection of text boxes and two panes. 

 The title bar: 

When the user specifies a product type (i.e. SL869, JN3, etc.), the 
type name will appear on this title bar, and the color scheme of the 
panel frame will change as an indicator that a product type has been 
selected by the user for the current connection. 

 The “Command string” box: 

This is the text box where the user types in the command string to 
send to the receiver. The text string that appears on this box contains 
the command string, and any parameters considered a part of the 
command string. Other characters such as hex representation of the 
checksum, will not be displayed in this box. 

Besides manual typing of the user, the data into this box can come 
from other methods (described in the sections that follow) before a 
particular message is to be sent. 

 The “Pause” button: 

User can click to toggle between pause and resume of update in the 
views of this window. 

Note:  

Anytime the “Pause” button on the main form toolbar is clicked to 
“resume” from “pause”, the “pause” of this button is released as well. 

 The “String to send” box: 

When a command string is displayed in the “Command string” box, 
TelitView will attempt to calculate appropriate checksum and append 
it to the string in real-time. The command string, along with the 
calculated checksum, will be displayed in this “String to send” box. 

By design, the default command string is a NMEA sentence-like 
messages, the message format contains checksum at the end and 
separate from the message body by “*”. So normal use will see the 
“$”, “*”, and a 2-bytes the checksum value. 

TelitView automatically adds a checksum to the command being 
sent. 

 The “RX” pane: 

This large “List Box’ style pane is the “receiving” monitor that displays 
the NMEA messages (both standard and proprietary) as TelitView 
receives them, either from the COM port serial data, or from a replay 
of a log file. 

To provide the user with a good visibility to the data traffic and context 
information, every command string sent from this panel is also 
displayed in the RX pane. 

 The “TX” pane: 

This pane is provided to display the command string the user sends 
when the “Send” button is clicked, as well as the acknowledgement 
message TelitView received after a command string is sent. 
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Note:    

The acknowledgement message in the “TX” pane provides feedback 
to the user as command strings are sent and allows the user to 
monitor the activity of the command send / receive sent.   

TelitView does not attempt to filter, parse, and display the 
acknowledgement messages based on the interface specification. 

In some cases, a receiver may send out multiple and variant length 
messages as a result from a command string; in that case TelitView 
will post a message to indicate the activity. 

 The checkbox “Raw Data”: 

When this is checked, TelitView will stop trying to add a checksum to 
the command string to be sent.   Instead, it will send the command 
string in the “Command” box across to the receiver without any 
appendance or change. 

With this provision checked, text string will be sent in its original form 
when “Send” button is clicked. 

 The checkbox “Append CR”: 

When this checkbox is checked, TelitView will add a Cartridge Return 
(character ‘\n’) to the end of the string shown in the “Command” box. 
This appendance occurs regardless if the command string has a CR 
character or not if this checkbox is checked. 

 Particular Features 

 Different Ways to Create a Command String 

In addition to manual type by the user to create a command string in 
the “Message” box, the box will take string from other ways as the 
input. 

After any one of the following scenarios, the user simply clicks the 
“Down” arrow and selects a string, and click “Send”. 

 From “History” list: 

All strings sent from this monitor (by clicking “Send”) are 
automatically saved by the program. In other words, the strings that 
are sent have been saved as a “history”. When TelitView is launched, 
this history is automatically loaded and made available to the 
“Message” box – it is a Dropdown box that lists the strings that have 
been sent before. 

 From the “Basic Commands” or “User Commands”: 

When the user selects one of the commands either from the “Basic 
Commands” or “User Commands” (by clicking the command), the 
action will place the command string in the “Message” box. 

 Copy-Paste from the Clipboard: 

The user can elect to copy a string from any source – to the clipboard 
– then paste it onto the “Message” box. 
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 Grab Message for Custom Messages Window 

As described from the Custom Messages Window, if the user would 
like to have received messages displayed in the Custom Messages 
window, the user needs to enter the message header as a filter to 
the Custom Message setting. 

One of the ways to supply such a message is to “grab” it from the 
NMEA Monitor’s “RX” pane. 

While the Custom Message window is open, the user may click the 
"Pause" button to pause the display, and locate a particular message 
to add it as a target message header, and then double-click on the 
message string. TelitView will grab the message and trim it to make 
a message header, and place it onto the “Message setting” box. 

 Signal Quality 

This window below displays the tracking states and signal quality of the satellites 
in CNo (dBHz.) 

 Their SVIDs and signal levels in the Signal Quality Chart view 

 The GNSS source, SVIDs,  satellite states and other real time 
parameters 

 The elevation and azimuth information in the Azimuth Elevation view 

 GLONASS satellites are shown in the circle. 

  

Figure 5-6: Signal quality view: GPS signal and satellite states 

With GNSS receiver, that supports GNSS (GPS, GLONASS, Galileo, BeiDou, 
etc.); the Signal Quality view will display the satellite constellation and the states 
information accordingly. 

The legend area along the bottom part contains the flags that indicate the status 
of the GNSS satellites at the current epoch.  These flags illustrate whether a 
satellite constellation (GPS, GLONASS, etc.) is being used in producing a 
position fix, is being tracked, or not. 

 When some satellites in a constellation are at the “use” status, the 
corresponding icon and the text will be highlighted (by the yellow 
color).  The above figure illustrates that GPS, GLONASS, and SBAS 
satellites are in the “use” state, as the hilighlights marked. 
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 The highlight is ON when at least more satellite is detected as at the 
“use” state. 

 

Figure 5-7 Signal quality view: the use status of GPS and GLONASS 

 

 When none of satellites in a constellation is being at the “use” status 
but one or more satelllites are being tracked (CNo > 0), the 
corresponding icon and the text “n/u” will be highlighted (by the yellow 
color).  The above figure illustrates that GPS satellites have been 
found at “use” (SVID = 25 is not used) at the moment, the GLONASS 
satellites are being tracked but none of them is being used. At this 
moment, the SBAS satellite (SVID = 48) is being tracked. 

 

Refer to the section 9.1 Display Examples of GNSS Signal for more examples. 

 Signal Level Bar Chart 

The right side of figure above illustrates the following information: 

SVIDs that are tracked and used.  SVIDs are shown along the X-axis, and for 
GPS constellation signals, the Space Vehicle ID (SVID) range is 1 through 32. 

 Signal quality  

The signal level for each satellite is shown as the attitude of each bar, 
along with its CNo value (dBHz). 

 Satellite Usage Flag  

“GPS Used” marker will be present if there is at least one satellite 
has the state of “1” – the satellite is being used for a position fix. 
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 Satellite Tracking States 

The left side of above figure illustrates the following information: 

 Source name (“Src”).  This name can be the combination of the 
following: 

o “GP” – GPS, 

o “GL” – GLONASS, 

o “GA” – GALILEO, 

o “BD” – BEIDOU, 

o “SB” – SBAS 

o “QZ” – QZSS 

 

 Other satellite state information: 

o Satellite ID (“SId”) – SVID, the same as in the Signal Level 
Bar Chart 

o Elevation (“Ele”) – the elevation of each satellite  

o Azimuth (“Azi”) – the azimuth of each satellite 

o State (“Sta”) – the state of the satellite: “1” indicate the 
satellite is used in solution.  

o CNo – Signal CNo numbers; it is the same as the bar 
height in the Signal Level Bar Chart on the right side. 

 Additional Information Control and Display 

 Average CNo: 

This box displays the average CNo value from all satellites that are 
in view on the current update. 

 Display Threshold: 

This is a user selectable control to adjust how he would like the 
satellite information to be displayed by selecting the minimum value 
for the signal CNo. 

 Azimuth Elevation 

The figure below illustrates the following information: 

 Satellite ID – numbers marked in pucks. 

 Elevation – the elevation of each satellite spread out along the 
concentric circles.   

 The radius indicates the elevation. 

 Azimuth – the azimuth of each satellite placed along radial angles. 

 State – the state of the satellite marked and color coded for its state.  
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Figure 5-8 Azimuth elevation 

The legend area cross the top part contains the flags that indicate the status of 
the GNSS satellites at the current epoch.  Their usage and meaning match those 
legends in the Signal Quality window. 

Refer to the section 5.4 Signal Quality for details about these icons and text. 

 

 Scatter Plot 

The Scatter Plot displays position points updated every second. The position 
points are compared to each other in an axis in meters. 

 

Figure 5-9 Scatter plot view 
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The “Navigation Update” pane displays the navigation update data, including the 
following 

 UTC time, 

 Latitude, Longitude, Altitude (HAE), 

 DOP = (√𝐻𝐷𝑂𝑃2 + 𝑉𝐷𝑂𝑃2),  

 Number of satellites in track. 

The “Info” pane contains the following elements: 

 A checkbox that allows user to specify if a reference position is to be 
used for plotting, 

 The reference position information (if a position is being used in 
plotting),  

 2DRMS error – this is the twice DRMS accuracy, with a 95% 
probability 

 CEP error – Circular Error Probability 

 Offset “E” and “N”: these fields indicate the offset, or bias, that has 
been calculated by TelitView, to the Easting and North direction, 
respectively.  The bias is from processing from the position fix data, 
with respect to the reference position being used in plotting.  If the 
position data, on the average basis, has the bias as 0, and the 
antenna that is feeding data to the GNSS module has the position is 
the true position to the reference being used, these values should be 
zero, or close to zero.  
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 Data Overview 

The Data Overview monitor displays an overview of some GNSS data: 

 

Figure 5-10 Data overview 

 Data Chart 

Data Chart window provides user selection control for several displays for some 
useful information.  The information display that have been implemented include 
the following: 

 Average CNo 

 Altitude (HAE) 

 Speed 

 HDOP 

 Number of  satellite in use 

 Number of satellite SV in view 

 Latitude 

 Longitude 

 

The meaning of the data is straightforward.  
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The following figures illustrate the display of the average CNo and the satellite 
in use with respect to the UTC time, based on the “Y:” dropdown list box, as 
shown. 

 

 

Figure 5-11 Data chart view – the trace of average CNo 

 

 

Figure 5-12 Data chart view – the trace of number of satellites in use 
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 Custom Messages Window 

TelitView supports different kinds of products / modules that are offered by Telit 
GNSS in a unified user interface. The Custom Messages window is a 
configurable message window for convenient and flexible interface to customize 
TelitView’s message handling windows.   

In this window, the user is provided with flexibility to customize different 
messages display by adding messages as the message filter.  The messages 
received by TelitView from the data source will be displayed in this message 
window, in addition to the regular NMEA Monitor window. 

In addition, the user can also remove messages from the settings list to reduce 
the message traffic into the window. 

 

 Access & Controls on the Window 

 Menu: Views > Custom Messages 

                     

Figure 5-13 Custom message window and controls 

 

The Custom Message window contains a collection of text boxes and two panes. 

 The target message header / talk ID: 

This field is for the user to enter a string of text as a message header. 
After being added to the message list by clicking the “Add” button on 
the panel (see below), TelitView will parse the text sentences or 
messages that TelitView is receiving and display them as the filtered 
messages if the messages contain the text string as the message 
header (the first part of a message). 

 The “Pause” button: 

User can click to toggle between pause and resume of update in the 
views of this window. 
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Note:  

Anytime the “Pause” button on the main form toolbar is clicked to 
“resume” from “pause”, the “pause” of this button is released as well. 

 The “Add” button 

User can click to add the text string in the “Target message 
header/talker ID” field to a “checklist” of TelitView for this feature. The 
parsing and filtering for the message header will not be in effect until 
the message header ID has been added to the checklist. 

 The “Remove” button 

This is the opposite of the “Add” button - user can click to remove a 
text string in the “Target message header/talker ID” field from the 
“checklist” of TelitView for this feature. Once a message header has 
been removed, parsing and filtering for that message header 
becomes none-exist. 

 Example shown in the screen capture: 

Above screen capture illustrates that a NMEA message ID of 
PSTM3DACC (as the talker + message type ID) is added to the 
“checklist”. 

After message has been added to the settings, all messages that 
contain the message header will be displayed in this window, along 
with any other messages that have added to the list the same way. 

 Configuration of Custom Message Settings 

For complete and detailed information on how to add, edit, and remove target 
messages from the parsing list, please refer to the section Error! Reference 
source not found. Error! Reference source not found.. 
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 INTRODUCTION TO TOOLS MENU 

The Tools menu contains the built-in tools in TelitView. 

 Replay of Data 

The TelitView “replay of log file” feature performs the following actions: 

 Open a log file that contains the log data from earlier runs, 

 Parse the data for valid messages, a.k.a. NMEA messages, and 

 Display and update the view window with the result from parsing, as 
TelitView would from receiving the messages through COM port. 

The “Replay Data”, “Pause”, and “Stop” buttons have the same function as the 
buttons on the toolbar, respectively. 

 Open Log File for Replay 

The access to open a log file is implemented in the Setup menu. 

 Menu: Setup > Replay 

 

Figure 6-1 Log file replay 

After user has entered a valid location for the log file for replay, TelitView will 
locate the file, open, and start to replay the messages contained in the log file. 

 Control the Speed for Replay 

 Menu: Tools > Replay Data 

 

 Figure 6-2 Tools menu 
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The replay speed is selectable with the following three options: 

 Normal – the same speed as the original data update rate. 

 As the default, the replay file is read (on the second basis) all NMEA 
messages before the next GPRMC message.  And the screen is 
updated accordingly. 

 Slow – the replay will be run at a half speed as in the Normal speed. 

 Fast – the replay will be run at a various speed based on how the 
“Fast” is selected. 

 With respect to the Normal speed, the first “Fast” will replay the file 
at twice speed.  Another click on “Fast” will result in the replay at 10 
times as fast.  This is the maximum speed for the file replay. 

 Pause and Resume 

User clicks “Pause” button to toggle pause or resume replay. 

 Stop Replay 

User clicks “Pause” button to stop replay. 

 User Commands Manager 

TelitView provides a highly flexible and user-friendly tool in the context of User 
Commands File.  This feature allows user to create user-defined commands, in 
the format of text strings, in a XML file, and store these commands in a XML file.  
User can then load the commands into TelitView and send a command string 
with a click on the command to a receiver. 

 Menu: Tools > User Commands Manager > Load User Commands To 
Menu 

 

Figure 6-3 User Commands Manager 

For more complete and detailed information about the User Commands File, 
including loading and editing, etc. with User Commands (New/Modify) menu as 
shown in figure above, please refer to the section Error! Reference source not 
found. Error! Reference source not found.. 
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 DR Control Panel 

The Dead Reckoning (DR) system is an important complementary enhancement 
to the GNSS positioning system.  The DR system utilizes various sensors, such 
as the gyro sensor, accelerometer, speed pulse/wheel tick, etc.), to calculate the 
position and produce the solution.  

This DR Control panel provides the data display, i.e. DR, Odometer, Gyro 
calibration, Gyro offset and Gain, as well as the access to more data view 
panels. 

 Menu: Tools > DR Control Panel 

 

Figure 6-4 DR Control Panel 

This Control Panel is the start point for user to monitor receiver’s output data, 
send commands as they are pertaining to receiver’s DR specific states, status, 
and performance related data. 

 Controls and Data Panes  

The panel consists of the following panes 

 Toolbar: 

o “Gyro and Acc” button: to bring out the Gyro and 
Accelerometer panel 

o “Clear Call” button: to send a command to clear the DR 
calibration. 

 Data panes: 

DR Calibration Status: indicates the calibration status bits for the 
following DR variables of calibration: 

o DR 

o Odometer gain 

o Gyro gain 

o Gyro offset 
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Vehicle Moving State: indicates some variables of vehicle moving 
states such as the following: 

o Speed (including meter/second, mile/hour, and 
kilometer/hour) 

o Heading 

o Direction (forward or reversed) 

o Latitude and Longitude as reference 

DR Gyro Status: indicates some variables of Gyro status such as the 
following: 

o Gyro offset 

o Gyro gain 

o Yaw rate 

DR Odometer Status: indicates some variables of vehicle Odometer 
Status such as the following: 

o Delta odometer count 

o Odometer scale 

o Odometer valid flag 

 Gyro, Accelerometer, and Odometer Data Panes 

The Gyro/Accelerometer/Odometer panel is brought up by clicking the “Gyro and 
Acc” button on the toolbar DR Control Panel. 

 

Figure 6-5 Launch DR Gyro and accelerometer data view 
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Figure 6-6 DR 3D Gyro & Accelerometer data view 

 The “Pause” button: 

User can click to toggle between pause and resume of update in the 
views of this window. 

Note:  

Anytime the “Pause” button on the main form toolbar is clicked to 
“resume” from “pause”, the “pause” of this button is released as well. 

 The Gyro, Accelerometer, and Odometer panes: 

This panel displays the updates of the following data in three panes 
respectively: 

o DR Gyroscope 

o DR Accelerometer 

o Odometer 

 The bar charts for raw data from Gyro and Accelerometer: 

Two horizontal bar charts are implemented for the raw data of X, Y, 
and Z as defined in the Gyro and Accelerometer data, respectively. 
They provide the user graphics representations of the data updates 
as they come in. 

If a hand-held receiver is used and maneuvered, the change of those 
variables are shown in the graphics. 

  



 

01VV0301168 Rev. 8 Page 53 of 123 2017-09-15  

 Command to Clear DR Calibration 

User can send a command to the receiver to cancel calibration by clicking the 
“Clear Cal” button on the toolbar DR Control Panel. 

 

 

Figure 6-7 Clear DR calibration 

The effect of this command is the DR calibration states in the receiver will be 
cleared. In addition, this state changes can be seen from the output of the 
receiver. 

If the DR calibration clear requires reset to the module, an information box will 
pop up to the user. 

User will click “OK” to acknowledge the information, but determines whether or 
when he will reset the module, by sending a “Reset” command or conducting a 
power cycle. 

 

Figure 6-8 Prompt on Clear DR-calibration 

 MO-DR Control Panel 

A positioning system of MEMS-DR is referring to a different GNSS + DR system 
that uses the Micro-Electro-Mechanical Systems (MEMS) sensors to provide a 
combination of sensor data (in place of, or in addition to the “classical” 
DRsensor) to assist in position fix or continuous navigation.  These data may 
include signals such as accelerometers, magnetometers, gyroscopes, and 
barometers that commonly found in motor vehicles. 

 

 Menu: Tools > MO-DR Control Panel 
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Figure 6-9 MO-DR Control Panel 

 MEMS-Only DR Menu Strip 

In this control panel across the top of the panel is the menu trip with three menu 
buttons:  

 

 

Figure 6-10 Menu strip on MEMS-Only DR Control Panel 

These buttons will be described as the following. 

 “Setup” button 

User can click this button to launch a MEMS-Only DR setup window, 
which has the capability to process relevant data to provide display 
that will help the installation – orientation and placement of the 
sensor. 
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 “IMU1T” button 

IMU is referring to Inertial Measurement Unit that uses a combination 
of accelerometers and gyroscopes, sometimes also magnetometers. 

User can click this button to launch a view window to display the data 
fields and the update of the Telit GNSS proprietary message 
“IMU1T”. 

 “IMU & Baro” button 

User can click this button to launch another view window to display 
the data fields and the update of the Telit GNSS proprietary 
messages “$PTWSIMU, RAW” and “$PTWSBARO, RAW”.  They are 
the output data of IMU unit and the barometer unit. 

 MODR Command selector 

User may choose a command from the dropdown list to send to the 
receiver. 

Currently supported commands include: 

o DR Cold Restart: DRCOLD 

o DR Factory Reset: FACTRST 

 Send Command Button 

Right next to the DR command selector is the “send command” 
button.  User clicks it to send the chosen command to the com port. 

 Speed and Course Meters for GNSS and DR 

This panel contains the analog meters to display the following: 

1) GNSS Speed (in unit of MPH or Km/h) 

2) GNSS Course in degrees 

3) DR Speed (in unit of MPH or Km/h) 

4) DR Course in degrees 

The speed unit is “MPH” at default, and is selectable with the check 
box “Km/h” to change to a Kilometer/hour. 
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 Navigation State Flags 

The row of flags, which is located below the tool bar strip, illustrates the 
navigation state of the MEMS-Only DR, based on the output Telit GNSS 
proprietary message. 

 

Figure 6-11 Navigation State Flags 

These status flags are defined as following, with the color code: 

 “220014.000” – the current UTC time tag. 

 “DRS” – DR sensor calibration status 

o White: none of the DR sensors is calibrated 

o Yellow: at least one sensor calibrated 

o Green: Calibration complete 

o  

 “Odo” – Odometer calibration status 

o White: Odo scale is not calibrated 

o Yellow: Calibration is progress 

o Green: Calibration complete 

 “GyTc” – Gyro temperature calibration status 

o White: Gyro temperature is not calibrated 

o Yellow: Calibration is progress 

o Green: Calibration complete 

 “GyOf” – Gyro offset calibration status 

o White: Gyro offset is not calibrated 

o Yellow: Calibration is progress 

o Green: Calibration complete 

 “AcTc” – Accelerator temperature calibration status 

o White: Accelerator temperature is not calibrated 

o Yellow: Calibration is progress 

o Green: Calibration complete 
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 “AcOf” – Accelerator offset calibration status 

o White: Accelerator offset is not calibrated 

o Yellow: Calibration is progress 

o Green: Calibration complete 

 “DR” – DR is GNSS compensated status 

o White: DR is not GNSS compensated 

o Blue: DR is GNSS compensated 

 “Hdg” – DR Heading is GNSS compensated status 

o White: DR Heading is not GNSS compensated 

o Blue: DR Heading is GNSS compensated 

 “Spd” – DR Speed is GNSS compensated status 

o White: DR Speed is not GNSS compensated 

o Blue: DT Speed is GNSS compensated 
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 MEMS Sensor SETUP Window 

The Setup window provides an intuitive view of sensor placement and 
orientation based on the measurement data at the output message IMURAW. 

 

Figure 6-12 MEMS sensor Setup Window 

Sensor orientation window 

The left side in the window is the “sensor orientation window”. In this window a 
big, solid color red dot represents the MEMS sensor; its position and orientation 
on the plot are determined by the variables of angles along the X axis, Y axis, 
and Z axis, respectively; the values are updated in real time as the module’s 
output data (IMURAW) is received and processed by the window. 

The use can view the movement of the dot that follows the adjustment of the 
state (rolling, yawing, and pitching) of the sensor. 

View of Sensor Placement and Adjustment 

As the sensor placement is moved around, its position in the plot changes 
around. 
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Figure 6-13 Sensor placement and orientation display  

The above screenshots illustrate how the plot is showing the orientation of the 
sensor, with the plot’s “auto zooming” feature.   

 The sensor position starts from far outside of the “target zone”, which 
is defined as a pie with the radius of 2-degree on the X axis direction 
and 2-degree on the Y axis direction.  

 As the sensor adjusts to a closer to the target zone, the target zone 
(the yellow color pie) appears. 

 When the sensor adjusts and falls into the zone, the scale of the plot 
changes again, and the zone turns to be a green pie, with the red dot 
is within the zone. 

Stop of “Auto Zooming” 

After the orientation of the sensor is optimized and settled, user may elect to 
“turn off” the “auto zooming” feature to avoid unnecessary data processing and 
updating to the plot by unchecking the “Zone Check” checkbox on the top-left 
corner of the plot. 

View of Sensor Orientation 

The following screenshots illustrate the orientation of a sensor with respect to 
the Y direction and Z direction. 
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Figure 6-14 Sensor orientation detection display 

MEMS sensor data display 

The MEMS sensor data display is located on the right hand side. 

 

Figure 6-15 MEMS sensor data panel 

This panel (above) displays the following data in constant update 
scheme: 

 MEMS setting temperator 

 Gyro Curate data along the X, Y, and Z axis 

 Accelerator Offset data along the X, Y, and Z axis 

 Accelerator Curate data along the X, Y, and Z axis 
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 MEMS Sensor Data Plots 

User clicks the “Sensor Data View” button from the panel above to launch the 
MODR Sensor Data Plot window, as shown below. 

 

Figure 6-16 MEMS sensor data plot window 

This window (above) displays the MEMS sensor data in plots. 

 IMU1T Data Display 

 

Figure 6-17 MEMS IMU1T data panel 
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 IMU Data and Barometer Data View 

PTWSIMU,RAW data pane 

This panel display the IMU data that contains the UTC time tag, IMU temperature 
reading, the gyro output data, and the accelerometer data. 

 

PTWSBARO,RAW data pane 

This pane display the UTC time tag, barometer temperature reading, and the 
barometer output data. 

 

Figure 6-18 IMU and baro data view 

Below the data listing of the IMU data and the barometer data are the graphs of 
the data: 

 “Imu T (deg)” - IMU temperature reading 

 “Gyro_X”, “Gyro_Y”, “Gyro_Z” – the output Gyro sensor data 

 “Acc_X”, “Acc_Y”, “Acc_Z” – the output accelerometer sensor data 

 “Baro T (deg)” – Barometer temperature reading 

 “Barometer (hPa)”: the barometer reading 
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 EPO Host Manager 

EPO stands for Extended Prediction Orbit – a type of server-generated extended 
ephemeris developed and supported by Mediatek®.  The EPO is very helpful in 
the effort to reduce Time-To-First-Fix (TTFF) in challenging RF environments 
affecting satellite signal reception. 

The EPO support is implemented with the two types: the EPO-II and the Host 
EPO.  The EPO Host Manager window provides all user interface and the 
controls the functionalities for the EPO feature. 

 

 Menu: Tools > EPO Host Manager 

 

Figure 6-19 EPO Host Manager Window 

The window is divided into upper half and lower half panes: 

 The EPO File Source Setup to set up and get the EPO file 

 The Assistance Data to transfer EPO and other assistance data to 
the client module 
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 EPO File Source Setup 

“EPO File Source Setup” pane in the upper half of the window: 

1) Specify all necessary information, such as URL name, 
credentials, and EPO file selection to access a remote EE 
server, and download the file from the remote EPO 
server. 

2) Alternatively, user can load from an EPO file that has 
been downloaded earlier and stored at a local media. 

 Get EPO 

After a user selects an EPO source from above – either the remote EPO 
server with the user-entered credentials, or the local directory, he shall click 
the “Get EPO” button to have EPO Host Manager go to the correct source 
location to load the file. 

After the EPO file passed validation check and is loaded into a temporary 
memory, the basic information values will be displayed in the data pane.  At 
this time, the display fields will indicate the file size, segment, and extension 
days, and the file is ready to be transferred to the client module. 

 EPO Data to GNSS Module Transfer 

There two methods of transferring EPO data to the client module: 

 The EPO-II method: User initiate the transfer of  the EPO data to the 
client module by clicking the “Update EPO” button. 

 The Host-EPO method: The transfer of the EPO data is a part of the 
Aided-GPS data send.  The Aided-GPS consist of a combination of 
the following aiding data: 

o System time 

o Reference Position 

o Host EPO (the transfer of EPO data) 

By design, the send of above aiding data is initiated when a reset or power-up 
message is issued from the client GNSS device and received by the host unit. 
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 EPO Status Inquiry and EPO Clear 

“Assistance Data” pane in the lower half of the window: 

 Query EPO Status and Clear EPO 

The buttons to query the current EPO-II state in the client module 
and clear the EPO data. 

 EPO Update Status Display 

“EPO Update Status” pane in the lower half of the window: 

 Displays the activities during the EPO transfer process (EPO-II and 
Host-EPO). 

The detailed description can be found in the section 8.EPO Feature. 

 Auto-baud to NMEA protocol 

Sometimes the baud rate of the UART at the connected GNSS device is not 
known to the user for him to set the baud rate at COM port of the PC.  Therefore, 
the PC is connected with the device via the correct COM port that is open, but 
the baud rate does not match. 

This “Auto-baud to NMEA” feature initiates a series of tries through setting 
different baud rate values (4800, 9600, etc.) on the PC COM port, and attempt 
to auto-detect the correct baud rate to make serial connection to the GNSS 
module’s UART port. 

Once a baud rate is considered “found”, the COM port will settle for the baud 
rate and thus a continuous serial communication is established. 

If the feature has run through the course of tries and failed to detect a valid baud 
rate, an information box will pop up, like the following: 

 

Figure 6-6-20 Auto-baud failed to detect baud rate 

At this time, user is expected to find other means to check the setup / software 
mode, to make sure that the device is outputting NMEA messages as expected. 
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 TELITVIEW FEATURES 

In a section that a feature-centric view of some TelitView functions are provided 
with detailed descriptions on their definition and usage. 

The features include the following: 

 Identify product 

 Log data 

 Configure message header to customied display 

 Create and maintain commands files 

 Configure reference position 

 Set-up and run LootpIt! Test 

 Create and use sessions with profiles 

 Convert data file for viewing and analysis 

 Auot-change baud rate 

 Special test settings 

 Identify Product 

As introduced earlier, in a situation that user would like to use a built-in 
command, TelitView must know the type of the module that it is currently 
communicating with, because the built-in commands are module-specific. 

Some products (hardware modules and their firmware) offered by TelitView 
GNSS use the same set of software command interface or protocol. The user 
must specify the types of the products with that TelitView is going to be 
interacting. 

Please refer to the section 3.2.2 About Telit Module Type for detailed information 
about the module types. 

 Access to the Product Selection Dialog Box 

 Menu: Setup > Products 

The Product Selection dialog box is for the user to enter selection for the product. 

Once the user clicks the OK button on the dialog box, the selection will be used 
by TelitView as the specifier that dictates the corresponding interface / command 
set. 

There are other ways to access the same Product Selection dialog box. 

 Connect to Receiver: 

Please refer to the section 3.2 Connecting TelitView with a GPS 
Receiver through a COM port for description. 

 Session & Connection Profiles: 

Please refer to the section Error! Reference source not found. 
Error! Reference source not found. for description. 
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 Product List 

The way the selection of a product has been changed; the list of modules has 
been enhanced from the last release of TelitView. 

 

 

Figure 7-1 Product selection display when no product has been selected 

There are two methods provided for the user to make selections: 

 Module Select – Telit GNSS Module names (shown in the left side 
box). 

 Chipset – GNSS chipset names as well as the Telit modules (shown 
in the right side boxes). 

Note:  

The box area below the Chipset selector will list the Telit modules 
that designed with the chipset. 

All selections are cross-selectable in that a click on any item will bring 
out context-sensitive update on other boxes. 

A particular module can be selected from different methods 
according to what a user likes, as described below. 
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 User’s Select from Module List 

If a user knows the module name, he can select it from the “Module Select” list. 

All Telit modules will be listed under the “Module Select” dropdown list, as 
shown. 

            

Figure 7-2 Product Selection 

Anytime a module, other than the “NON-SPECIFIC”, is selected from the list, the 
corresponding chipset name, as well as all the Telit modules in the same chipset 
family will be displayed in the “Telit Modules” box. 

In the above example, the selection of SL869-V2 module will bring up the chipset 
MT3333 in the “Chipset” dropdown list, as well as other member modules that 
contains the MT3333 device.  In the list , the selected module, SL869-V2, is also 
highlighted as the current selection. 

User may click “OK” to select the module. 
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 User’s Select from Chipset List 

If a user chooses to start from a chipset name, he would choose a chipset from 
the “Chipset” list. 

All chipset types will be listed under the “Chipset” dropdown list, as shown below. 

 

Figure 7-3 Chipset list 

Anytime a chipset type, other than the “NON-SPECIFIC”, is selected from the 
Chipset list, all the Telit modules in the same chipset family will be displayed in 
the “Telit Modules” box. 

 

Figure 7-4 Modules under a chipset selection 

In the example below, the device “SiRFstar 4e” is selected in ”Chipset” 
dropdown list, the selection will bring out the module names that are in the same 
chipset, as shown : JF2, JN3, and SE880. 

Notice that “Module Select” field is empty at this time and the user is expected 
to make a selection from the member modules under the “Telit Modules” box. 

 

Figure 7-5 A Telit Module is selected based on chipset 

Once user clicked the selection, (i.e. “JN3”), the “Module Select” field will be 
populated with the module name, as shown in the figure. 

User may click “OK” to select the module. 
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 What is expected from the Product Identification 

The “NMEA Monitor” view is the primary interface the user interacts with the 
GNSS receiver connected to TelitView. The product selection will trigger the 
NMEA Monitor to change its frame color if the window is already open. 

The product type will also be shown on the title bar of the window, as indicated 
in the figure. 

     

The main form title bar will be updated with the product identifier as well. 

 

Figure 7-6 NMEA Monitor before and after a product selection  

 

    

If the NMEA Monitor is launched after the product has been selected by user, 
the later opened window will also have the frame color changed. 

Once the product selection is made, the command set is automatically loaded 
into the program that is product-specific for use. 

The command set is available under the menu Commands > Basic Commands. 

Note:    

The user has the responsibility to make sure, when commands and run 
tests are sent; the correct product type (module name) is identified to the 
program. 
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 Log Data to Files 

This section provides the detailed description on how to use the log file features 
in TelitView. 

 

 Menu: Setup > Start Log 

 

 

Figure 7-7 Log data configuration dialog box 

 Log File Types 

Data of input / output at the COM port can be logged into disk files in 
two approaches.  They are described as the following: 

1) All Serial Data 

When selected, this file type records the data as byte stream, which 
means the data can be text lines that include the standard NMEA as 
well as the product proprietary NMEA messages. 

The data can also include binary data bytes that are often used for 
debugging purpose. 

Because this type of data does not conform to any standard known 
to TelitView, TelitView does not examine data and distinguish the 
contents, rather simply records them into a file under this selection. 

2) NMEA messages 

When selected, this file type will record the data that is “text” lines in 
format, and it conforms to the NMEA standard - sentences starting 
from a ‘$’ character and ending with a valid checksum after a ‘*’ 
character. 

The two log file names (with paths) are set separately; they are not 
allowed to share the same file name in the same directory. 
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 Logger Mode 

Logger mode is provided to help minimize the possibility of data loss in situations 
where a high data density is present at the com port.  When a module produces 
the output of high volume of data per second, it requires extended time of PC to 
process data and perform graphics update in real time.  

The data save with minimal data loss, if any, can be helped if user elect to close 
all windows that he does not need to view data on, and only leave the necessary 
windows open. 

When the Logger mode is selected, TelitView will limit data feed to the windows 
to minimize processing and graphics update, and allow the data to be saved into 
file in the maximum bandwidth that is offered by the PC. 

The following windows still get data feed, thus updates, if user elect to leave 
them open on the screen: 

 NMEA Monitor Window 

 Signal Quality Window 

 DR Control Panel 

 MO-DR Control Panel 

 

When a data logging is on under the logger mode, the data log icon will have a 
background of special color, as shown below: 

 

Figure 7-8 Logging data with Logger mode ON 
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 PC Time stamping 

This feature allows a user to insert a timestamp mark to each message (NMEA 
sentence) that is logged in the file type of NMEA message. 

The following examples show the effect of PC time stamping. 

 

 
 
 
 
 
 
 
 
 

Figure 7-9 Log file with no timestamping 

 
 
 
 
 
 
 

 

Figure 7-10 Log file with timestamping 

Note:  

This feature is only available for the log file type of NMEA messages. 

 Start Log 

The two log files (if the user elected to log both) are started and stopped at the 
same time, with a single click. 

After setting either one file (or both), a user can click “Start to Log” button, to 
actually start logging. 

Once data logging starts, the title bar in TelitView will show the logging file status, 
as below. 

 
Figure 7-11 Title bar shows the status of logging file 

$GPGSA,A,3,15,18,27,19,21,24,22,14,,,,,1.15,0.81,0.82*04 
$GLGSA,A,3,88,65,81,87,66,,,,,,,,1.15,0.81,0.82*1D 
$GPGSV,3,1,10,22,64,322,29,14,56,193,30,18,52,042,33,21,51,112,34*74 
$GPGSV,3,2,10,51,49,161,31,27,47,275,25,19,30,308,26,24,21,076,19*7D 
$GPGSV,3,3,10,15,11,043,18,04,03,308,*7E 
$GLGSV,3,1,09,88,72,213,19,65,53,007,18,66,44,275,28,81,38,324,29*6E 

13:46:17:565,$GPGSA,A,3,15,18,27,19,21,24,22,14,,,,,1.14,0.80,0.81*07 
13:46:17:565,$GLGSA,A,3,88,65,81,87,66,,,,,,,,1.14,0.80,0.81*1E 
13:46:17:566,$GPGSV,3,1,10,22,64,327,38,14,59,193,28,18,51,045,33,21,49,115,28*70 
13:46:17:566,$GPGSV,3,2,10,51,49,161,30,27,47,272,30,19,32,306,28,24,21,074,24*71 
13:46:17:567,$GPGSV,3,3,10,15,09,043,16,04,05,309,16*79 
13:46:17:568,$GLGSV,3,1,09,88,69,207,23,65,51,010,30,66,45,279,32,81,41,322,21*60 

13:46:17:568,$GLGSV,3,2,09,87,23,167,24,75,11,100,14,74,10,050,,72,09,048,*64 



 

01VV0301168 Rev. 8 Page 74 of 123 2017-09-15  

 Stop Log 

 

Figure 7-12 Stop log 

User can click the “Stop Log” button either from the “Setup” menu or from the 
icon on the toolbar, to stop logging process. 

After data logging is stopped, the title bar in TelitView will display the updated 
logging status showing that the log files are closed. 
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 Immediate or Scheduled Logging 

The data logging can be set up in the following ways. 

 User-start and user-stop 

User starts and stop logging with his clicking buttons.  The user has 
a full, manual control and the operation is immediate. 

User can make a selection in “All Serial Data” or “NMEA messges” 
log file type, or both, by clicking the corresponding checkbox, then 
clocking “Start to Log” button, to start logging immediately.  Refer to 
the section Error! Reference source not found. for more details. 

The logging will continue until it is stopped by user.  Refer to the 
section Error! Reference source not found. Error! Reference 
source not found. for more details. 

 Scheduled logging 

User may elect to schedule a file logging by set up the start date/time 
and stop date/time. 

(1) User controls for the scheduled logging 

 

 

 Figure 7-13 Scheduled logging 

 Start Time 

User can pick the date and time as the start-time for logging from the 
“Time” and “Date” picker. If no time / date is picked, the presumed 
start time for logging activity is “now” at the time the “Start to Log” 
button is clicked. 

There is a two-minute period: the same as “now” period.  If user sets 
up to scheduling a start within two minutes (120 seconds) away from 
the current time – in other words, a starting delay of less than two 
minutes from the current time, the schedule mechanism will treat it 
the same as “now”, and will start the file immediately. 

  



 

01VV0301168 Rev. 8 Page 76 of 123 2017-09-15  

 Stop Time 

User can pick the date and time as the stop-time for logging from the 
“Time” and “Date” picker. If no time / date is picked, there will be no 
presumed stop time – logging will not stop until it is stopped by the 
user. 

 Specified Length 

User may elect to enter the log length in form of “minutes” in the 
“Specified Length” field.  The minute-length value is synchronized 
with the “Stop” time / date picker - the scheduler will update the 
values automatically in the“Stop” time / date picker. 

  Scheduling choices 

User chooses the “Start” time and “Stop” time as he desires.  He 
enables the selection of the “Time” picker and “Date” picker by 
clicking the corresponding checkbox first. 

Please note that, the time picker display the time in the form of 
“hh:mm:ss”, but the “second” value is ignored by the scheduler.  That 
means the schedule (start and stop) is in effect on the hour and 
minute level, not at the second level.   

 Specifying only the start time 

 

Figure 7-14 Start time is enabled 

If the “Start” time is enabled but the start “Date” is not, as shown 
above, the “Start” date will be assumed the same as the current 
(today). 

By the same concept, if only the “Start” date is enabled, the “Start” 
time will be assumed the same as the current (now). 

If user clicks the “Schedule Log” button, the logging will start at the 
specified time (or assumed) on the day as specified (or assumed). 

 Specifying only the stop time 

 

Figure 7-15 Stop time is enabled 
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If the “Stop” time is enabled but the stop “Date” is not, as shown 
above, the “Stop” date will be assumed the same as the current 
(today). 

By the same concept, if only the “Stop” date is enabled, the “Stop” 
time will be assumed the same as the current (now). 

If user clicks the “Schedule Log” button, the logging will start logging 
immediately and stop logging at the specified time (or assumed) on 
the day as specified (or assumed). 

 Specifying both the start and stop time 

 

Figure 7-16 Stop time is enabled 

If both the “Start” and “Stop” time is enabled, as shown above, 
TelitView will start logging and stop logging automatically at the time 
as specified. 

 Specifying logging length (in minutes) 

 

Figure 7-17 Stop time is enabled 

 

The logging length can be specified in the term of minutes – user 
enter the number of minutes into the “Specified Length” field. 

Take a note that the unit is the “minute”, the following data comes as 
example: 

 One hour: 60 

 Two hour: 120 

 One day (24 hours): 1440 

 

The figure below illustrates a log file has been scheduled. 
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Figure 7-18 Display the file time and schedule 

Scheduled logging cancelling 

 

Figure 7-19 A logging has been scheduled 

 

When user choose to cancel by clicking the “disk” button, as shown 
above, the “Log Data Configuration” dialog box will pop up and the 
button “Cancle Schedule” will be highlighted, as shown below. 

Notice that user entries are all disabled at this state.  The user can 
either click the “Cancel Schedule” button to cancel the scheduled 
logging, ot click “Cancel” to abort any operation further… the 
schedule remains active. 

 

Figure 7-20 Cancel a scheduled logging 

 

 



 

01VV0301168 Rev. 8 Page 79 of 123 2017-09-15  

 Setup Information Block in Log File 

Every time TelitView starts to log data to file, it will poll the firmware version 
strings from the receiver and save the version information to the log file. 

In addition, other information, as listed as the following, will be saved to the log 
file as well: 

 Log type – the “All serial” data or “NMEA message” data 

 Firmware version string – the SDK version and Telit 
GNSS version, where it is applicable 

 Logger mode – it is ON or OFF 

The following example illustrate how the setup information is interleaved with the 
rest of the logging data in a log file. 

The setup information block starts with a “Setup Info Block” banner and ends 
with a “***…” text line. 

 

 

 

 

 

 

 

 

 Configure Message Headers for Customized Display 

The NMEA Monitor, referring to section 5.3 NMEA Monitor, is the primary user 
view window that allows a user to see the activities of the input/out messages 
between TelitView and the connected module at the COM port. 

Sometimes it is highly desirable that user is provided with a capability to set up 
a “message filter” to filter out messages so that only the messages that contain 
the same headers as what are registered at the Custom Message window are 
displayed. 

This Custom Messages window is the tool that TelitView provides to user, for 
this purpose. 

$GPTXT,(C)2000-2011 ST Microelectronics*20 

$GPTXT,Telit version v33-4.5.2-MODR-0.9.4A-NR115-B1-ARM*70 

*********** Setup Info Block ************ 

Log type: NMEA message data 

SDK FW ver: $GPTXT,Telit version v33-4.5.2-MODR-0.9.4A-

NR115-B1-ARM*70 

Logger mode: ON 

***************************************** 

$PSTMGETSWVER,255*17 

$GPGST,172925.000,6.6,11.0,7.1,0.5,10.3,8.1,8.7*6A 
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Figure 7-21 Custom Message Window 

 Message Header 

A messages header is defined as the first field of a text line received by TelitView 
from its data source. The “first field of the” text line is defined as the text present 
before the first comma “,” encountered in the received text line. 

The user should only use the first part of a text string, before the first comma, as 
the message identifier for the program to parse and display.  TelitView will not 
parse the text line as a whole for this purpose. 

 Add Message to Settings 

The user may use one of the following methods to add a message header to the 
window as the settings: 

 Manual typing 

 Typical “copy & paste” operation (from the Clipboard) 

 “Grab and enter” from NMEA Monitor window 

If the user would like to set a particular message shown in the NMEA Monitor 
window and add it to the settings, the user can make the data traffic pause first, 
then “double-click” the message.  The program will automatically grab that line, 
trim it to get the first field, and fetch it to the “Custom view message settings” 
field. 

Note:   

The user needs to click “Add” button in order to set or enable this 
new message header to take effect. 
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 Remove Message from Settings 

The user can elect to remove a message from the settings by first select it from 
the list (to place it on the settings field”, then click “Remove” button. 

 Persistence of the Settings 

The settings, after configuration above, will be automatically saved.  The same 
setting will be reloaded on the next launch of the program. 

 Create and Maintain Commands Files 

TelitView provides methods to send commands or messages to connected 
receivers with extended flexibility. 

These methods and flexibility are implemented with two text files in XML format: 

 Basic Commands 

This file contains contents created as the default, built-in by 
TelitView. They are product specific. 

 User Commands 

This file contains contents created and maintained by the user. They 
are custom created and product and customer specific to meets all 
kinds of testing and control purpose for the customer. 

 Contents of the Commands Files 

Both Basic Commands file and the User Commands are in XML format. 

The following is an example of how a command file looks like. 

 

Figure 7-22 Example of commands file 

A Command file of XML format contains the following components: 

 Command description 

Example: “Perform a COLD start”. 

 Command text line 

Example: $PMTK103 
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 How TelitView Handles the Commands Files 

By design, TelitView handles the two files differently. 

 Basic Commands File 

This file is created and installed by the TelitView Installation package.  
The installation process creates the folder Basic Commands in the 
installation folder, together with the TelitView executable. 

o This file is not intended as editable by a customer. 

o This file is automatically loaded into TelitView every time 
user select a product / module type (from the Product 
Selection dialog box). 

 User Commands File 

This file is created and loaded by the user. 

o This file is created and maintained by user. 

o Because it is in XML format, an XML editor program or 
alike is required to create and edit this file. TelitView 
provides a user interface to enable the user to create and 
edit entries in this file. 

o This file has to be loaded by user. 
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 Create User Commands (in User Commands File) 

 User the User Command Manager 

 Menu: Tools >User Command Manager >User Commands 
(New/Modify) 

 

Figure 7-23 User Commands Editor 

The User Commands window (or editor) provides the following boxes and 
buttons to enter / edit each user command entry, and save into a disk file 
specified by the user. 

 User starts to create a user command by clicking the “New” 
button 

For each entry of a user command, it has these fields: 

 “Index”:  

An index count managed by TelitView. 

 “Command Description”:   

A text string that serves as a descriptive title for the command.  This 
command description appears on the user command list after the 
user elects to load them. 

 “NMEA Command”:  

A text string for an actual command string (or sentence, message) 
sent to the receiver. 

 NMEA Command Syntax 
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These commands strings are proprietary NMEA messages – they 
start with “$”, and may contain none or multiple delimiters “,” to 
separate each parameter fields if applicable. 

Note:  

These command strings are the raw data only – they are not 
expected to include the checksum at the end of the command string 
here. 

 Save User Commands to the User Commands File 

After the user creates the user commands, use the “Browse” and 
“Save” the commands to a disk file in a folder with a file name the 
user knows where to load from. 

 Access to Commands (Provided with Commands Files) 

 Load Commands 

The Basic Commands file is loaded automatically by TelitView every 
time the user selects a product type from the “Product Selection” 
dialog box. 

The User Commands file has to be loaded by user from a folder. 

 Menu: : Tools >User Command Manager >Load User 
Commands to Menu 

 Access to Commands 

The commands provided through the Basic Commands file and User 
Commands file are accessible in the same menu: 

 Menu: Commands >Basic Commands 

 Menu: Commands >User Commands 

They are shown in the two figures below. 

 

     

Figure 7-24 Access to commands 
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 Send Commands 

The Basic Commands and User Commands provide a flexible way for the user 
to create and use commands. Sending the commands across is implemented 
through the message “hub” for receiving / sending messages – that is, the NMEA 
Monitor window. 

 Configure Reference Position 

A reference position is a position, specified as a set of Latitude, Longitude, and 
Altitude values used by the program as reference on which the Scatter Plot is 
drawn. 

 How to Configure TelitView to Use a Reference Position 

 Use First Position as the Reference 

As the default configuration, TelitView will use the first position fix 
(using GPGGA message it received as nominal) as the reference 
position.  When its Scatter Plot is open and the axes are drawn on 
the window, the origin of the axes is positioned as the reference point. 

 Use a User Entered Position as the Reference 

Additionally, the user may elect to configure the program to use a 
reference position entered and saved. 

 Selections in the Box 

 Menu: Tool > Set Reference Position. 

The format is a pure decimal value for the latitude, longitude in degree. 

 

 

Figure 7-25 Reference Position 

 Set as Default 

This selection enables the program to use the position every time it 
starts, and to draw the position on the Scatter Plot window. 

 Set to use now 

The selection sets the program to use this position once the user 
clicks the OK button. 
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Without this item being checked, on exit of this dialog box the new 
position will not be used immediately.  The position used on the next 
TelitView launch depends on whether the “Set as Default” is 
checked, and whether the setting “Save/Update” is checked on exit 
of this dialog box. 

 Save/Update 

The setting data is saved by TelitView and is available the next time 
TelitView is launched. 

Without this item being checked, on exit of this dialog box, the new 
data will not be saved and will not be persistent. 

 Data source as the reference position 

If the Host-EPO feature is to be used, as described in the 
section 8.2.2 Host EPO (Host-EPO Method), 3 Host EPO, this 
window is the place to set up the reference position. 
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 Choose Whether to Use Reference Position for plot 

If a reference position is available to the program, the “Info” panel in the Scatter 
Plot indicates whether the reference position is used or not. 

 

 

 

Figure 7-26 Use of reference position in Scatter Plot 

First, the “Use” check box is a status indicator, showing whether the available 
reference position is being used or not. From the “Reference Position” dialog 
box, if the user has the checkbox of “Set to use now” checked and press OK, 
this checkbox is expected to show that. 

The “Use” check box can also be used as a command to “set” whether to use 
the available reference position or not. By clicking it, the plot will toggle between 
using the reference position and not using it. 

Note:  

 Every time such a configuration occurs, the existing plot will be 
cleared and a plot will start over again.  
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 Use a Current Position as the Reference 

Inside the Scatter Plot “Navigation Update” panel, the user may elect to use a 
current position as a new reference upon which the plot will be plotted. This 
feature is implemented with a button click on “Set”. 

Once the “Set” button is clicked, the Scatter Plot data will reset and the current 
position, in form of latitude and longitude, will be used as the reference point for 
plot from this point moving forward. 

In addition, the Reference Position dialog box will be brought up for user to 
configure how the new position data will be used, the same way as the menu 
selection: 

 Menu: Tool > Set Reference Position. 

 Setup and Run LoopIt! Test 

To easily run repeated tests, TelitView provides a test suite called LoopIt!Test. 

The most fundamental test is the Test Mode “0: Default”. It is a TTFF oriented - 
a repetition of resets wherein the user can specify basic parameters to run a 
repeated test. 

 Menu: Test > LoopIt! Test 

 

 

Figure 7-27 LoopIt dialog box 
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As seen from the left panel, the parameters include the following: 

 The test type 

 Repetition (Cycles) 

 Nav seconds 

 Timeout (Sec) 

Other types of tests can be developed, under different test modes, to support 
various testing purpose. 

 Insert Nav Seconds 

User may insert some delay seconds after a position fix has been reached, 
before the next cycle of reset kicks in. This delay will not take place if the receiver 
is not in nav. 

User may elect to use one of the three methods to insert the nav seconds: 

 The checkbox “Rand”:  

Inserts the delay seconds generated randomly by the program, with 
the range [0…30] seconds. 

 The checkbox “OnWard": 

Inserts the delay seconds that goes in step onward, with the range 
[0…30] seconds. 

 The default 

Inserts the fixed value for the delay seconds specified in the “Nav 
Seconds” field. 

 TTFF Test Stats 

Test result statistics can be seen on the right side panel, which includes: 

 Maximum TTFF 

 Average TTFF 

 The number of Timeouts 

The meaning of each parameter is self-explanatory. 
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 Create and Use Sessions with Profile Feature 

The session elements are the implementation in TelitView application that allow 
running of multiple instances of the program on a same machine. Each run of 
an instance of TelitView is always within a context of a “session”. 

The session feature compartmentalized variables in the setup and execution 
within a session-specific directory in the computer’s hard drive. Each session on 
which TelitView is running will retrieve and store its own variables and setups. 
Multiple instances of run at the same time by the application will not cause 
conflicts on the setups and variables. 

 What is a Session 

First, each session is identified by a session identifier, a Session ID. 

A session ID is a numerical value from 0 to a maximum number. Currently the 
maximum number of session is 20, which means, the valid range of session ID 
is between 0 and 20 inclusive.  Any number larger than the 20 will be rejected 
by the program. 

In addition to the session ID, the following elements are components of a 
session: 

 Description:  

A text field that provides a “memo” style writing area. It is for user to 
enter brief text information to describe about the session, its key 
connection parameters, etc. 

 COM port:  

A COM port name for serial connection. 

 Baud rate:  

A baud rate for serial connection. 

 Telit Module:  

A module type identifier. 
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 Sessions & Connection Profiles 

 Access to the Session Configuration dialog box: 

 Menu: Setup > Sessions 

 

Figure 7-28 Launch the session feature 

 

 The Session Configuration Dialog Box 

The Session and Connection Profile dialog box is illustrated in the 
figure below. 

 

 

   Figure 7-29 Session & Connection profile configuration 

 Fields of the Session and Profile 

Refer to the Session Configuration dialog box, for the following fields: 

1. Session ID:  

A dropdown list and editable field to allow user to choose a session 
from the list, or enter a value as a new session ID to add. 
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2. Description: 

An editable text field to allow user to write a brief description as a 
memo to indicate the key parameters for the session, the purpose, 
etc. 

This field is also a dropdown list that contains the descriptions of the 
existing sessions that have been created by user, and they are 
available as reference. 

3. COM port: 

A list of COM ports found available on the machine. 

User clicks the arrow key to select a port to be used for the session. 

The checkbox on the right side of the COM port: a checked state is 
to indicate the port is available.  A COM port can be defined in one 
or more sessions and it will be found in the list, but the port can be at 
a busy state at the particular time.Baud rate:  

A list of standard baud rates that can be used. 

User clicks the arrow key to select a baud rate for the session. 

4. Telit Module:  

A list of the Telit module types supported by the TelitView program. 

User clicks the arrow key to select a module type for the session. 

5. Update Session Profile:  

A check box that user clicks when he wants to use the field values to 
have the session profile updated when he clicks the “Run” button. 

6. “Run”:  

A button that user clicks to exit from the dialog box and run the new 
session immediately. 

If the “Update Session Profile” checkbox is checked, the session file 
data will be updated, and the new data will be persistent. 

7. “New”:  

A button disabled normally, but becomes enabled when the user 
attempts to add a new Session ID, by entering a new value in the 
Session ID field (1). 

The user clicks this button to add a new session, and TelitView will 
bring focus to and highlight the “Description” field (2) to prompt user 
to enter the brief description for the session. 
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8. “Delete”:  

A button for session management purposes. 

User clicks to delete a particular session from the existing session 
list. On execution of this command, the session is deleted and no 
longer exists in the session list. 

9. In Use:  

A list of sessions that are detected by TelitView to be at busy state. 
This is an un-editable field. 

It provides the user visibility about the run status of other sessions. A 
busy session will not be available to run by the user at the particular 
time. 

10. “Cancel”:  

A button to abort changes, if any, and exit from the dialog box. 
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 Examples of User Case 

1) A Single Instance Run at a Default Session (Session 0) 

When running TelitView as a “single” instance (only one instance of 
TelitView is launched and running), the user does not need to do 
anything more for the similar situation. 

2) A Single Instance Run at a User-Created Session (Session 
3) 

The following figure illustrates scenarios that TelitView is running on 
a custom-created Session 3, as indicated at the TelitView status bar. 

TelitView will use the setup parameters and windows placement data 
of the previous run of TelitView when it closes. 

 

 

Figure 7-30 Single instance run of TelitView 

3) Multiple Instance Runs (Different Sessions) 

Based on the session structure in multiple instance runs, creating 
different sessions is necessary. 
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Figure 7-31 Multiple instance runs of TelitView 
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 Convert Data File 

This section provides a description of a feature in TelitView to perform the 
conversions from the GNSS data file that to some popular files that user can 
view in the Google Earth application. 

 File Conversion Dialog Box 

 Menu: Setup > Convert 

 

Figure 7-32 File conversion dialog box 

 Data Formats in File 

 Source File 

The data format that is expected by TelitView to read: 

A text format file that contains GPS coordinates in the standard 
NMEA sentences. 

User browses or specifies the file path and name as the source file 
that TelitView will read from and the conversion is conduct upon. 

The file format supported is expected to be a text format file that 
contains standard NMEA sentences, such as the NMEA file 
generated with TelitView as the data log file. In addition to the 
standard NMEA sentences, the source data file may contain other 
text messages or proprietary NMEA sentences, and they will be 
ignored by the conversion process. 

If the log file generated by TelitView with the PC “timestamping” 
turned ON, the time stamp information will be ignored and the 
conversion will not be affected. 
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 Conversion Type 

There can be various data types that conversions will gradually add 
and support.  The selection is made through the pick on the 
“Conversion Type” dropdown list. 

Currently, the supported conversion is to convert the standard NMEA 
sentences found in the source file into a .kml file or .nmea format, the 
data formats that are recognizable by Google Earth as an input. 

o .kml file 

o .nmea file 

In this example a conversion to a .kml file type is choosen. 

 Output File 

User browses or specifies the file path and name as the output file 
as a result of conversion. 

 Run Conversion 

 Convert File 

User clicks “Convert” button to start the conversion. 

The conversion progress is illustrated by the progress bar, and on 
completion of conversion, the “Done” button will replace the initial 
“Cancel” button and user clicks it to exit from the dialog box. 

 

Figure 7-33 Convert file 

The number of the NMEA sentences found in the conversion is also 
displayed in the dialog box (in this example, the number of sentences 
= 1471). 

 Display Tracks by Loading into Google Earth 

User can open the resultant file of NMEA format from Google Earth 
and have the navigation track displayed (only a part of display is 
illustrated). 
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Figure 7-34 Display the track with Google Earth 

 

 Auto-Change Baud Rate 

When TelitView sends a command string to change the baud rate on the UART 
of the GNSS module, if the command is recognized as a built-in command by 
TelitView, it will automatically change the baud rate on the current COM port to 
match the new baud rate. 

This feature is turned on by default – but user has a control to disable it.  Refer 
to the section Error! Reference source not found. Error! Reference source 
not found. for details. 

The entry source that can be recognized by TelitView is from the following: 

 A user-entered string in the “Command string” box in the NMEA 
Monitor 

 A command from the “Basic Commands” 

 A command from the “User commands” 

This feature is supported in all GNSS products, as listed in the section Error! 
Reference source not found. Error! Reference source not found.. 
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 Special Test Settings 

 Menu: Test > Special Test Settings 

This dialog box allows user to set up various testing flags or TelitView system 
conditions that are special or to change the default behavior of TelitView. 

 

Figure 7-35: Special test settings 

Currently the special test setting offered in TelitView for setups contains the 
following 

 Auto-change Baud rate Enabled 

 Disable EASY on reset 

Their use is described in detail next. 

 Auto-Change Baud Rate Enable/Disable 

As default, when TelitView sends a command string to change the baud rate on 
the UART of the GNSS module, if the command can be recognized as a built-in 
command by the program, after the command is sent across, TelitView will 
automatically change the baud rate on the current COM port on PC to match the 
new baud rate. 

However, there are some testing situations that this auto-change feature is not 
desired, so, the feature can be controlled by user by checking/unchecking the 
corresponding check box. 

If the feature is disabled, under the user’s command to change the baud rate on 
the UART of the module, TelitView still sends user’s command string cross, but 
will not attempt to auto-change the baud rate of the serial port on the PC to 
match the new baud rate.  In this scenario, the user will see a freeze of data 
activities on the NMEA Monitor window (if it is open).  It becomes user’s 
responsibility to disconnect/reconnect the serial port with the new baud rate that 
matches the new UART baud rate of the UART, to re-establish the serial 
communication. 
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 Disable EASY on Reset 

The EASY is a navigation solution feature developed and supported by 
Mediatek®. 

There are some testing situations that EASY is ON is not desired.  To force to 
turn off the EASY on reset, check the “Disable EASY on reset” checkbox. 

With this being checked on, TelitView would send a command string to the 
MT33xx module, to turn off EASY on every start-up message from power-on 
event or a reset event at the client module 
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 EPO FEATURE 

The EPO stands for Extended Prediction Orbit – a type of server-generated 
extended ephemeris developed and supported by Mediatek®. 

 EPO Source Setup and Get EPO 

 Menu: Tools > EPO Host Manager 

The following figure illustrates how it looks like after launching the EPO Host 
Manager. 

 

Figure 8-1 EPO Host Manager 

 EPO File Source Setup 

User selects one of following two ways to specify how to get the EPO data ready 
for transfer to a client module. 

 EPO Server 

 When the “EPO Server” checkbox is checked, it is expected that the 
user is going to download an EPO file from a remote server. 

 

User enter the information needed to locate the correct EPO server 
and provide credentials and file name to download an EPO file. 
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Figure 8-2 EPO Host Manager: EPO file source setup 

 Local EPO File (default) 

 When the “Local EPO File” checkbox is checked, user uses the 
browse button (as circled below), if desired, to locate an EPO file that 
has been stored in the local media. 

The “default” indicates that EPO Host Manager Window start always 
s with the local file as the EPO file source. 

Notice that, in order to minimize confusion, when the checkbox is 
checked for the local EPO file, the file name for the EPO server is 
greyed out, indicating that information is not being used. 

 

Figure 8-3 Browse for local EPO file 
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 EPO File Properties and Their Selections 

Based on the EPO-II specifications, EPO files offered for download at the EPO 
server contain “properties” that differentiate each file from another, such as 
GNSS constellation selection and the validity length. 

As a convenience provided for customer, these properties are reflected in the 
name of each file. 

The EPO Host Manager window has an “EPO File Attributes” pane to assist user 
in EPO file property selection or display. 

These controls are used differently when the EPO source is using “EPO Server” 
or “Local EPO File”. 

 When the “EPO Server” is selected as the EPO source, it is 
expected that the user is going to download an EPO file from 
the server.  Thus the EPO file attributes controls are used as 
a “configurator” used by the EPO Host Manager to form a 
proper file name and display it in the “File Name” for the EPO 
Server download. 

This pane is illustrated by the following diagram: it exemplifies 
attributes of GPS only, 7 day validity length for an EPO file. 

This file name will be sent, along with the server address, user 
name, and the password, to the EPO server for the download 
of the EPO file. 

 

 

Figure 8-4 EPO file of GPS only and the file name 

 When the “Local EPO File” is selected as the EPO source, it is 
expected that the user locates the EPO file from a local storage 
media.  Thus the EPO file attributes controls turn to be an 
“indicator” displayed to user as the properties of the file, based 
on the file name. 

If the file name is the same as that in the EPO server (thus in 
compliance with the name standard of what the Telit EPO server 
uses) for the same properties, then the EPO file attributes will 
display the same contents. 
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Figure 8-5 Local EPO file of GPS only 

Examples: 

 The following example illustrates that a user selected a satellite type 
of GPS + GLONASS with validity length of 6 hours; the EPO file for 
download is EPO_GR_6h.DAT. 

 

Figure 8-6 EPO file of GPS + GLONASS and the file name 

 The following examples illustrates that a local EPO file has been 
detected as a GPS only with 14 day validity length properties. 

 

Figure 8-7 Local EPO file of GPS only and 14-day validity 
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 Get EPO 

After a user selects an EPO source from the above – either the remote EPO 
server with the user-entered credentials, or the local directory, he can click the 
“Get EPO” button to have TelitView go to the correct source location to get the 
EPO file. 

Note:  

If the EPO file is from a server, the download process may take a 
second or two, and the file will be automatically saved at the user’s 
“\Downloads” directory as default. Thus, a user always has an option 
to use “Local EPO File” as the EPO source by browsing to the 
“\Downloads” directory to get the file. 

After the target, EPO file passed validation check and is loaded into a temporary 
memory; the following fields will be populated with the values indicating the file 
size, segment, and extension days that are pertaining to the EPO file. 

 

Figure 8-8 Get EPO file - success! 

The above data illustrates the following “envelop” information for a complete 
EPO file that is GPS only and 14 days of validity duration: 

o File Size: 129024 bytes. 

o Segments: 56. 

o Extension Days: 14 

In the case of getting EPO from a server, if the process failed, a message box 
can pop up like this: 

 

Figure 8-9 EPO file download failed 
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 EPO Transfer to Module 

 Update of EPO (EPO-II Method) 

User clicks the “Update EPO” button to initiate the transfer of the EPO data to 
the client module, using the EPO-II method. 

 

Figure 8-10 EPO download with EPO-II method 

 

After user clicks the button to update EPO, the transfer process starts … until all 
packets of EPO data are transferred.  The resultant activities are shown in the 
following diagram. 

 

Figure 8-11 Success of EPO-II download 
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Some highlights of the process: 

 A number of packets will be sent to the module for any EPO file.  In 
this case, a total of 598 packets are sent. 

 EPO validity length is 14 days, and there are 56 segment (aka 
epochs) data in this transfer. 

 On completion of the transfer, a query of EPO command will be sent 
by the EPO Host Manager and the EPO status data pane will be 
updated with latest status of the EPO. 

Selection of EPO Validity Length for Transfer 

EPO Host Manager allows user to custom-select a different validity length of 
EPO data to transfer, other than the EPO file entirely.  Obviously, a valid range 
of the validity length is the one that is smaller than, and can be up to the whole 
validity length of the EPO file. 

For any validity length selection, smaller than the full file, EPO Host Manager 
transfers a partial EPO file from the start, and stops the specified the length. 

 

Failure in EPO Data Transfer 

During the transfer of EPO data to the module using the EPO-II method, even 
though it is not required for the host to wait an Acknowledgement message for 
each EPO data packet received by the module, the presence of the 
Acknowledgement messages for the packets can be used as an indicator 
whether the transfer is occurring or not. 

The following figure illustrates that no Ack messages are observed, that means 
a transfer is not happening. 

 

 

Figure 8-12 EPO downloading but it is not happening 

The above situation can occur as a result of possible causes such as the client 
module and the host are not communicating, the client module is a ROM based 
device that does not accept EPO-II (a flash EPO oriented), etc. 
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 Host EPO (Host-EPO Method) 

The EPO Host Manager window has the “Host Aiding” panel for user to set up 
the Host-EPO feature.  

The Host EPO process is initiated when a system start-up message, 
$PMTK010,001 is received by the host, thus in this panel what a user shall do 
is to enable the host-aiding messages, by checking the corresponding 
checkboxes, that will be sent to the client module. 

There are three host-aiding messages that are defined by the Host-EPO 
protocol, which the user can activate: 

 System time 

A user can check the “System Time” box to enable the EPO Host 
Manager to provide the system time to the client module.  A time in 
UTC format is required for system aiding. 

 Reference Position 

A user can check the “Ref Position” box to enable the EPO Host 
Manager to provide a reference position to the client module. 

The fields cannot be empty when it is to be set as the reference 
position.  User must set it before this feature can be used.  The 
position information used here is the same source as those in the 
section Error! Reference source not found. Error! Reference 
source not found.. 

 Host EPO 

A user can check the “Host EPO” box to enable the EPO Host 
Manager to send the Host EPO data to the client module. 

The Host EPO data is sent in the form of proprietary NMEA text 
strings; each string contains a single satellite EPO data. 

The following diagram illustrates that all three host aiding messages 
are activated by the user, and after the user issue a reset command 
(i.e. a WARM restart),  
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Figure 8-13 Host EPO setup 
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The TTFF from this WARM reset is 4.2 second, as shown in the following 
diagram.  

 

 

Figure 8-14 TTFF of Warm restart with Host EPO aiding 

 

 

Figure 8-15 Host EPO aiding update status 

 System time sent: “PMTK740, 2015,7,14,23,43,40” – 23:43:40 
07/14/2015 

 Reference position sent:  
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 “PMTK741, 33.670678, -117.653925, 0, …” – lat = 33.670678, lon = 
-117.653925, alt = 0m, etc. 

 Host EPO sent: EPO file: C:\EPO_GPS_14.DAT 

 Unhealthy satellite: SVID = 8 

 Debug messages: Current time and the EPO time, etc. 

 

 Assistance Data Panel 

 

Figure 8-16 EPO Host Manager: Assistance data 

 

 Query EPO Status 

 A user can query the current EPO status in the receiver by clicking 
“Query EPO Status” button.  The response data from the receiver will 
populate the status fields as shown in the figure below. 

 

 

Figure 8-17 Response data to Query EPO status 
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 Clear EPO 

 A user can clear the EPO stored in the receiver by clicking “Clr EPO” 
button. 

 

Figure 8-18 Response data to Clear EPO 
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 APPENDIX 

 Display Examples of GNSS Signal  

The following figure illustrates GNSS signals in the form of combination of 
constellations that are found in the Telit GNSS modules. 

 GNSS Signal Charts: GPS + GLONASS 

These figures illustrate the GNSS signals in the form of GPSS + GLONASS: 

 Their SVIDs and signal levels in the Signal Quality Chart view. 

 The GNSS source, SVIDs, satellite states and other real time 
parameters. 

 The elevation and azimuth information in the Azimuth Elevation view. 

 GLONASS satellites are shown in the circle. 

 

GPS + GLONASS output from SE873 

 

Figure 9-1: Signal quality view: GPS + GLONASS from SE873 

 

 

Figure 9-2: Azimuth and elevation: GPS + GLONASS from SE873 
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GPS + GLONASS output from SL871 

 

Figure 9-3 Signal quality view: GPS + GLONASS from SL871 

 

Figure 9-4: Azimuth elevation: GPS + GLONASS from SL871 

 

GPS + GLONASS output from SL869 

 

Figure 9-5: Signal quality view:  GPS + GLONASS from SL869  
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Figure 9-6: Azimuth elevation from GPS + GLONASS from SL869 

 GNSS Signal Charts: GPS + BeiDou 

These figures illustrate the GNSS signals in the form of GPSS + BeiDou: 

 Their SVIDs and signal levels in the Signal Quality Chart view. 

 The GNSS source, SVIDs, satellite states and other real time 
parameters. 

 The elevation and azimuth information in the Azimuth Elevation view. 

 BeiDou satellites are shown in the circle. 

 

GPS + BeiDou output from SE873 

 

Figure 9-7: Signal quality view: GPS + BeiDou from SE873 
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Figure 9-8: Azimuth elevation view: GPS + BeiDou from SE873 

GPS + BeiDou output from SL871 

 

Figure 9-9: Signal quality view: GPS + BeiDou from SL871 

 

Figure 9-10: Azimuth elevation view: GPS + BeiDou from SL871 
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GPS + BeiDou output from SL869 

 

Figure 9-11: Signal quality: GPS + BeiDou from SL869 

 

Figure 9-12: Azimuth elevation: GPS + BeiDou from SL869 
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 GNSS Signal Charts: QZSS 

The following figure illustrates the use status QZSS: 

 SVID = 193, and its signal level is shown in the Signal Quality Chart 
view 

 

 

Figure 9-13 Signal quality view: QZSS from SL871 

 

 

Figure 9-14 Azimuth elevation view: QZSS from SL871 
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 GNSS Signal Charts: GPS + GALILEO 

These figures illustrate the GNSS signals in the form of GPSS + Galileo: 

 Their SVIDs and signal levels in the Signal Quality Chart view. 

 The GNSS source, SVIDs, satellite states and other real time 
parameters. 

 The elevation and azimuth information in the Azimuth Elevation view. 

 Galileo satellites are shown in the circle. 

 

 

Figure 9-15 Signal quality view: GPS + Galileo from SL871 

 

 

Figure 9-16 Azimuth elevation view: GPS + Galileo from SL871 
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 GNSS Signal Charts: GPS + GLONASS + GALILEO 

 

Figure 9-17 Signal quality view: GPS + GLONASS + Galileo from SL871 
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 FAQ and Error Info 

 Error: “The serial is not ready” 

When this error box pops up, it indicates the program attempted but failed to 
open the serial port with the name as specified. A normal cause is that the port 
is unavailable. 

 

Figure 9-18 Prompt for COM port setup failure 

There can be different reasons for a serial port to become unavailable. 

For example, a port used in a connection profile, also known as a session, may 
become unavailable if it is used by another instance of TelitView. Another 
example is when the USB cable is disconnected, the operating system has 
removed it from the list of ports. 

 Information: A session is running by another TelitView 

This dialog box indicates when a TelitView starts at a particular session; the 
same session has been running (by another instance of TelitView). 

 

Note:  

TelitView does not prevent user from running an instance on the 
same session. It only warns user if multiple instances of TelitView are 
running the same session, then they share the same connection 
profile parameter and may change the parameters that are not 
expected. 

 

Figure 9-19 Prompt for concurrent running session 
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 Information: “Do you want to update them in the Session setup” 

When this dialog box pops up, it is because some parameters of the serial port 
have been changed, and the parameters are part of the connection profile.  As 
a result, the user is prompted to be aware the change will affect the session. 

 

  

Figure 9-20 Prompt for updating/overwriting a session setup 

 Information: Module has not been selected or auto detected 

As stated in the section 3.2.2 About Telit Module Type, in any situation that user 
would like to use a built-in command, TelitView must know the type of the module 
with that it is currently communicating. 

When TelitView checks, and finds that the module type information is not 
available, the following message box will pop up. 

 

Figure 9-21 Module type has not been selected or auto detected 

At this time, user shall refer to the section 3.2.2 About Telit Module Type for 
details on how to select the module type. 
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